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INTRODUCTION

One of the simplest forms of a foundation is the shallow foundation. In this exercise we will
model such a shallow foundation with a width of 2 meters and a length that is sufficiently long
in order to assume the model to be a plane strain model. The foundation is put on top of a 4m
thick clay layer. The clay layer has a saturated weight of 18 kN/m3 and an angle of internal
friction of 20°.

Figure 1: Geometry of the shallow foundation.

The foundation carries a small building that is being modelled with a vertical point force.
Additionally a horizontal point force is introduced in order to simulate any horizontal loads
acting on the building, for instance wind loads. Taking into account that in future additional
floors may be added to the building the maximum vertical load (failure load) is assessed. For
the determination of the failure load of a strip footing analytical solutions are available from for
instance Vesic, Brinch Hansen and Meyerhof:
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This leads to a failure load of 117 kN/m2 (Vesic), 98 kN/m2 (Brinch Hansen) or 97 kN/m2

(Meyerhof) respectively.
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SCHEME OF OPERATIONS

This exercise illustrates the basic idea of a finite element deformation analysis. In order to
keep the problem as simple as possible, only elastic perfectly-plastic behaviour is considered.
Besides the procedure to generate the finite element mesh, attention is paid to the input of
boundary conditions, material properties, the actual calculation and inspection of some output
results.

Aims

• Geometry input

• Initial stresses and parameters

• Calculation of vertical load representing the building weight

• Calculation of vertical and horizontal load representing building weight and wind force

• Calculation of vertical failure load.

A) Geometry input

• General settings

• Input of geometry lines

• Input of boundary conditions

• Input of material properties

• Mesh generation

B) Calculations

• Initial pore pressures and stresses

• Construct footing

• Apply vertical force

• Apply horizontal force

• Increase vertical force until failure occurs

C) Inspect output
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GEOMETRY INPUT

Start PLAXIS by double-clicking the icon of the PLAXIS Input program. The Quick select
dialog box will appear in which you can select to start an new project or open an existing
one. Choose Start a new project (see Figure 2). Now the Project properties window appears,
consisting of the two tabsheets Project and Model (see Figure 3 and Figure 4).

Figure 2: Quick select dialog

Project properties

The first step in every analysis is to set the basic parameters of the finite element model.
This is done in the Project properties window. These settings include the description of the
problem, the type of analysis, the basic type of elements, the basic units and the size of the
drawing area.

The Project tabsheet

Figure 3: Project tabsheet of the Project Properties window

In order to enter the proper settings for the footing project, follow these steps:
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• In the Project tabsheet, enter “Exercise 1” in the Title box and type “Elasto-plastic
analysis of drained footing” or any other text in the Comments box.

• In the General options box the type of the analysis (Model) and the basic element type
(Elements) are specified. As this exercise concerns a strip footing, choose Plane strain
from the Model combo box. Select 15-node from the Elements combo box.

• The Acceleration box indicates a fixed gravity angle of -90°, which is in the vertical
direction (downward). Independent acceleration components may be entered for pseudo-
dynamic analyses. Leave these values zero and click on the Next button below the
tabsheets or click on the Model tabsheet.

The Model tabsheet

Figure 4: Model tabsheet of the Project properties window

• In the Model tabsheet, keep the default units in the Units box (Length = m; Force = kN;
Time = day).

• In the Geometry dimensions box the size of the considered geometry must be entered.
The values entered here determine the size of the draw area in the Input window.
PLAXIS will automatically add a small margin so that the geometry will fit well within
the draw area. Enter Xmin=0.00, Xmax=14.00, Ymin=0.00 and Ymax=4.25.

• The Grid box contains values to set the grid spacing. The grid provides a matrix of dots
on the screen that can be used as reference points. It may also be used for snapping to
regularly spaced points during the creation of the geometry. The distance of the dots is
determined by the Spacing value. The spacing of snapping points can further be divided
into smaller intervals by the Number of snap intervals value. Enter 1.0 for the spacing
and 4 for the intervals.

• Click on the Ok button to confirm the settings. Now the draw area appears in which the
geometry model can be drawn.
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Hint: In the case of a mistake or for any other reason that the project properties
should be changed, you can access the Project properties window by
selecting the Project properties option from the File menu.

Creating the geometry

Once setting the project properties have been completed, the draw area appears with an
indication of the origin and direction of the system of axes.

The cursor is automatically switched in the Geometry line drawing mode. If not, the user can
change the drawing mode to Geometry line by clicking the geometry line button .

In order to construct the contour of the proposed geometry as shown in Figure 5, follow these
steps. (Use Figure 5 for orientation, it represents the completed geometry).

Figure 5: Geometry model

Create sub-soil

• Position the cursor (now appearing as a pen) at the origin (point 0) of the axes (0.0; 0.0).
Click the left mouse button once to start the geometry contour.

• Move along the x-axis to (14.0; 0.0). Click the left mouse button to generate the second
point (number 1). At the same time the first geometry line is created from point 0 to point
1.

• Move upward to point 2 (14.0; 4.0) and click again.

• Move to the left to point 3 (0.0; 4.0) and click again.

• Finally, move back to the origin (0.0; 0.0) and click the left mouse button again. Since
the latter point already exists, no new point is created, but only an additional geometry
line is created from point 3 to point 0. PLAXIS will also automatically detect a cluster
(area that is fully enclosed by geometry lines) and will give it a light colour.
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• Click the right mouse button to stop drawing.

This action created the sub-soil cluster. The next step is to introduce the footing.

Create footing

• Position the cursor at point 4, (6.0, 4.0) and click the left mouse button once.

• Move vertical to point 5, (6.0; 4.25). Click the left mouse button to generate a vertical
line.

• Move horizontal to point 6, (8.0; 4.25). Click the left mouse button to generate a horizontal
line.

• Generate a second cluster by clicking the left mouse button on coordinate (8.0; 4.0).

• Click the right mouse button to stop drawing.

This action created the footing.
The proposed geometry does not include plates, hinges, geogrids, interfaces, anchors or
tunnels. Hence, you can skip the corresponding buttons in the second toolbar.

Hints: Mispositioned points and lines can be modified or deleted by first choosing the

Selection button from the toolbar. To move a point of line, select the point or
the line and drag it to the desired position. To delete a point or a line, select the
point or the line and press the Delete key on the keyboard.

> Undesired drawing operations can be restored by pressing the Undo button

from the toolbar or by selecting the Undo option from the Edit menu or by
pressing <Ctrl><Z> on the keyboard.

Hint: The full geometry model has to be completed before a finite element mesh can be
generated. This means that boundary conditions and model parameters must be
entered and applied to the geometry model first.

Hint: During the input of geometry lines by mouse, holding down the Shift key will
assist the user to create perfect horizontal and vertical lines.

Input of boundary conditions

Boundary conditions can be found in the second block of the toolbar and in the Loads menu.
For deformation problems two types of boundary conditions exist: Prescribed displacements
and prescribed forces (loads). In principle, all boundaries must have one boundary condition
in each direction. That is to say, when no explicit boundary condition is given to a certain
boundary (a free boundary), the so-called ’natural condition’ applies, which is a prescribed
force equal to zero and a free displacement. In order to avoid the situation where the displacements
of the geometry are ’undetermined’, some points of the geometry must have prescribed
displacements. The simplest form of a prescribed displacement is a fixity (zero displacement),
but non-zero prescribed displacements may also be given.
To create the boundary conditions for this exercise, follow the steps below.
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Prescribed displacements

Click on the Standard fixities button on the toolbar or choose the Standard fixities option
from the Loads menu to set the standard boundary conditions. As a result PLAXIS will
automatically generate a full fixity at the base of the geometry and roller conditions at the
vertical sides (ux=0; uy=free). A fixity in a certain direction is presented as two parallel lines
perpendicular to the fixed direction. Hence, the rollers appear as two vertical parallel lines and
the full fixity appears as cross-hatched lines.

Hint: The Standard fixities option is suitable for most geotechnical applications. It is
a fast and convenient way to input standard boundary conditions.

Vertical load

Click on the Point load - load system A button on the toolbar or choose the Point load
- static load system A option from the Loads menu to enter another point force. Click on the
coordinate (7.0, 4.25) to enter a point force. As a result PLAXIS will automatically generate a
vertical point force on the indicated point with a unity force (f = 1).

Horizontal load (see also next step "Changing direction .....")

Click on the Point load - load system B button on the toolbar or choose the Point load -
static load system B option from the Loads menu to enter a point force. Click on the coordinate
(7.0, 4.25) to enter a point force. As a result PLAXIS will automatically generate a vertical point
force on the indicated point. As a horizontal force is needed, the direction of load B needs to
be changed.

Changing direction and magnitude of loads

Choose the Selection button from the toolbar. Double click on the geometry point 8 with
coordinate (7.0, 4.25) which will display a box as indicated in Figure 6. Select Point Load -
load system B, click OK and enter 1.0 as x-value and 0.0 as y-value. These values are the
input load of point force B. Click OK to close the window.

Input of material properties

In order to simulate the behaviour of the soil, a proper soil model and corresponding parameters
must be applied to the geometry. In PLAXIS, soil properties are collected in material data sets
and the various data sets are stored in a material database. From the database, a data set
can be assigned to one or more clusters. For structures (like walls, plates, anchors, geogrids,
etc.) the system is similar, but obviously different types of structures have different parameters
and thus different types of data sets. PLAXIS distinguishes between material data sets for Soil
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Figure 6: Select window and Point load window

& Interfaces, Plates, Anchors and Geogrids. The creation of material data sets is generally
done after the input of boundary conditions. Before the mesh is generated, all material data
sets should have been defined and all clusters and structures must have their appropriate data
set.

Table 1: Material properties of the clay layer and the concrete footing.
Parameter Symbol Clay Concrete Unit

Material model Model Mohr-Coulomb Linear elastic —
Type of behaviour Type Drained Non-porous —

Weight above phreatic level γunsat 16.0 24.0 kN/m3

Weight below phreatic level γsat 18.0 — kN/m3

Young’s modulus Eref 5.0·103 2.0·107 kN/m2

Poisson’s ratio ν 0.35 0.15 —
Cohesion c 5.0 — kN/m2

Friction angle ϕ 20 — °
Dilatancy angle ψ 0 — °

The input of material data sets can be selected by means of the Material Sets button on
the toolbar or from the options available in the Materials menu.

Create material data sets

To create a material set for the clay layer, follow these steps:

• Select the Material Sets button on the toolbar.

• Click on the <New> button at the lower side of the Material Sets window. A new dialog
box will appear with five tabsheets: General, Parameters, Flow parameters, Interfaces
and Initial (see figure 7).

• In the Material Set box of the General tabsheet, write “Clay” in the Identification box.

• Select Mohr-Coulomb from the Material model combo box and Drained from the Material
type combo box.
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• Enter the proper values for the weights in the General properties box according to the
material properties listed in table 1

• See also figure 8 and figure 9. In these figures the Advanced parameters part has been
collapsed.

Figure 7: General tabsheet of the soil and interface data set window for Clay

• Click on the Next button or click on the Parameters tabsheet to proceed with the input of
model parameters. The parameters appearing on the Parameters tabsheet depend on
the selected material model (in this case the Mohr-Coulomb model).

• Enter the model parameters of table 1 in the corresponding edit boxes of the Parameters
tabsheet. The parameters in the Alternatives and Velocities group are automatically
calculated from the parameters entered earlier.

• Since the geometry model does not include groundwater flow or interfaces, the third and
fourth tabsheet can be skipped. Click on the OK button to confirm the input of the current
material data set.

• Now the created data set will appear in the tree view of the Material Sets window.

• For the concrete of the footing repeat the former procedure, but choose a Linear Elastic
material behaviour and enter the properties for concrete as shown in table 1 (see also
figures 9 and 10).
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Figure 8: Parameters tabsheet of the soil and interface data set window for Clay

Figure 9: General tabsheet of the soil and interface data set window for Concrete

Figure 10: Parameters tabsheet of the soil and interface data set window for Concrete
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Assigning material data sets to soil clusters

• Drag the data set “Clay” from the Material Sets window (select it and keep the left mouse
button down while moving) to the soil cluster in the draw area and drop it there (release
the left mouse button). Notice that the cursor changes shape to indicate whether or not
it is possible to drop the data set. When a data set is properly assigned to a cluster, the
cluster gets the corresponding colour. Drag the concrete material set to the footing and
drop it there.

• Click on the OK button in the Material Sets window to close the database.

Hint: PLAXIS distinguishes between a project database and a global database of
material sets. Data sets may be exchanged from one project to another using
the global database. In order to copy such an existing data set, click on the
Show global button of the Material Sets window. Drag the appropriate data set
(in this case “Clay”) from the tree view of the global database to the project
database and drop it there. Now the global data set is available for the current
project. Similarly, data sets created in the project database may be dragged
and dropped in the global database.

Hints: Existing data sets may be changed by opening the material sets window,
selecting the data set to be changed from the tree view and clicking on the Edit
button. As an alternative, the material sets window can be opened by double
clicking a cluster and clicking on the Change button behind the Material set box
in the properties window. A data set can now be assigned to the corresponding
cluster by selecting it from the project database tree view and clicking on the
OK button.

> The program performs a consistency check on the material parameters and will
give a warning message in the case of a detected inconsistency in the data

Mesh generation

When the geometry model is complete, the finite element model (mesh) can be generated.
PLAXIS includes a fully automatic mesh generation procedure, in which the geometry is
automatically divided into elements of the basic element type and compatible structural elements,
if applicable. The mesh generation takes full account of the position of points and lines in the
geometry model, so that the exact position of layers, loads and structures is reflected by
the finite element mesh. The generation process is based on a robust triangulation principle
that searches for optimised triangles, which results in an unstructured mesh. This may look
disorderly, but the numerical performance of such a mesh is usually better than for regular
(structured) meshes. In addition to the mesh generation itself, a transformation of input data
(properties, boundary conditions, material sets, etc.) from the geometry model (points, lines
and clusters) to the finite element mesh (elements, nodes and stress points) is made.
In order to generate the mesh, follow these steps:

• Click on the Generate mesh button in the toolbar or select the Generate option from
the Mesh menu. After the generation of the mesh a new window is opened (PLAXIS
Output window) in which the generated mesh is presented (see Figure 11).
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• Click on the Close button to return to the geometry input mode.

Figure 11: Generated finite element mesh of the geometry around the footing

If necessary, the mesh can be optimised by performing global or local refinements. Mesh
refinements are considered in some of the other exercises. Here it is suggested to accept the
current finite element mesh.

Hints: By default, the Global coarseness of the mesh is set to Medium, which is
adequate as a first approach in most cases. The Global coarseness setting
can be changed in the Mesh menu. In addition, there are options available to
refine the mesh globally or locally.

> At this stage of input it is still possible to modify parts of the geometry or to add
geometry objects. In that case, obviously, the finite element mesh has to be
regenerated.

Press the close button to close the output program and return to PLAXIS input.
Creating the input for this project now finished. Press the green Calculation button on the
toolbar to continue with the definition of the calculation phases.
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CALCULATION

After the finite element model has been created, the calculation phases need to be defined.
This analysis consists of four phases. In the initial phase the initial pore pressures and
stresses are generated, in the first phase the footing is constructed, during the second phase
the vertical load is applied and in the third phase the horizontal load is applied.
When starting the PLAXIS Calculation program the Calculation mode window appears. In
this window the user can choose how he wants PLAXIS to handle pore pressures during the
calculation. This is important when calculating with undrained behaviour and/or groundwater
flow. In this first exercise this is not important and so the default setting of Classical mode is
chosen. Press <OK> to close the Calculation mode window. PLAXIS now shows the General
tabsheet of the initial phase (see Figure 12).

Figure 12: General tabsheet of the initial calculation phase

Initial phase (generation of initial conditions)

Before starting the construction of the footing the initial conditions must be generated. In
general, the initial conditions comprise the initial groundwater conditions, the initial geometry
configuration and the initial effective stress state. The clay layer in the current footing project is
fully saturated with water, so groundwater conditions must be specified. On the other hand, the
situation requires the generation of initial effective stresses. As we want to include the footing
construction in the simulation process, the footing should not be present in the initial situation
(prior to construction). In PLAXIS it is possible to switch off clusters in order to calculate
correct initial effective stresses. The initial stresses in this example case are generated using
the K0-procedure. The initial conditions are entered in separate modes of the Input program.
In order to generate the initial conditions properly, follow these steps:

• In the phase list select the initial phase
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• Make sure the Calculation type is set to K0-procedure on the General tabsheet. This is
the default setting.

• Go to the Parameters tabsheet by clicking the Parameters button or by directly selecting
the tabsheet.

• On the Parameters tabsheet press the Define button located in the Loading input box.
This will start a window presenting the problem in Staged construction mode. In Staged
construction mode it is possible to switch on and off various parts of the geometry,
change loads, apply strains etc.

• In the initial condition of this exercise, that is the situation before we start constructing
our project, the footing is not present. Therefore the footing has to be deactivated. In
order to do so, click on the area that represents the footing so that it will change color
from the material set color to white. The footing is now disabled.

• Click on Water conditions in the button bar in order to move to the Water conditions
mode of the program.

• Select the Phreatic level button .

• Position the cursor (appearing as a pen) at coordinate (0.0, 4.0) and click the left mouse
button to start the phreatic level.

• Move along the x-axis to position (14.0, 4.0). Click the left mouse button to enter the
second point of the phreatic level.

• Click the right mouse button to stop drawing.

• Press the Water pressures button to view the pore pressures.

The pore pressures are generated from the specified phreatic level and the water weight.
Directly after the generation, a PLAXIS Output window is opened, showing the pore pressure
as presented in Figure 13. The colors indicate the magnitude of pore pressure. The pore
pressures vary hydrostatically, ranging from 0 kN/m2 at the top to -40 kN/m2 at the bottom.

• Close the output program in order to return to the input program.

• Click on Update in order to save the changes made and return to the PLAXIS Calculations
program. This completes the definition of the initial conditions.

Hints: For the generation of initial stresses based on the K0procedure it is necessary
to specify the coefficient of lateral earth pressure, K0. This K0value is defined
per material set and therefore has to be set when entering material set data. If
the K0value is not explicitly set PLAXIS uses a value according to Jaky’s
formula (K0 = 1-sin(ϕ)).

> The K0 procedure may only be used for horizontally layered geometries with a
horizontal ground surface and, if applicable, a horizontal phreatic level.
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Figure 13: Initial pore pressures

First calculation phase (construction of footing)

• Click on the Next button . This will introduce a new calculation phase and
present the corresponding tabsheets for the first calculation stage. Enter a suitable name
in the Number/ ID box (e.g. ‘Construction of footing’).

• Select the second tabsheet called Parameters. On this sheet Staged construction is
selected by default in the Loading input combo box. Click the Define button. This will
open the window presenting the problem in Staged construction mode.

• Click on the cluster that represents the strip footing, in order to switch on the footing
(original colour should reappear).

• Click on Update to conclude the definition of the first calculation phase. Updating will
automatically present the calculation window.

Second calculation phase (apply vertical load)

• Click on the Next button . This will introduce a new calculation phase and present the
corresponding tabsheets for the second calculation stage. Enter a suitable name in the
Number/ ID box (e.g. ‘apply vertical load’).

• Select the Parameters tabsheet. On this tabsheet accept the selection Staged construction
in the Loading input combo box. Click on the Define button. This will open the window
presenting the problem in Staged construction mode.

• Click on the point forces in the middle of the footing, a Select items window comes up.
Select the Point load - Load System A to activate point load A and press the Change
button to change the load value. Change the y-value to -50 kN/m and press the Ok
button.
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Figure 14: Parameters tabsheet of the first calculation phase

• The point load A is now active (blue) and has a load value of 50 kN/m.

• Press Update.

Figure 15: Select items window

Third calculation phase (add horizontal load)

• Click on the Next button to add another phase. This will present the tabsheets for
the third calculation stage. Enter a suitable name in the Number/ID box (e.g. ‘apply
horizontal load’).

• Select the second tabsheet called Parameters. On this sheet accept the selection
Staged construction in the Loading input combo box. Click on the Define button.

• Click on the point forces in the middle of the footing, select the Point load - load system B
to activate point load B and press the Change button to change the load value. Change
the load x-value to 20 kN/m2 and press the Ok button.

• Press the Ok button to closed the Select items window.

• Press Update.
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Fourth calculation phase (vertical load to failure)

• Click on the Next button . This will present the tabsheets for the fourth calculation stage.
Enter a suitable name in the Number/ID box (e.g. ‘vertical load – failure’).

• Directly below the Number/ID box select from the Start from phase dropdown list the
second calculation phase. By selecting this the 4th phase will be a continuation of the
2nd phase, hence we will continue to apply the vertical load without having the additional
horizontal load that was applied in phase 3.

• Select the second tabsheet called Parameters. On this sheet choose the selection Total
multipliers in the Loading input group box. Select the third tabsheet called Multipliers by
either clicking on the Define button or directly selecting the tabsheet.

• Enter a ΣMloadA of 10. In this way the working force is increased to a maximum load of
10 x 50 = 500 kN/m.

In PLAXIS two methods exist to increase an active load. The magnitude of the
activated load is the input load multiplied by the total load multiplier. Hence, in
this excersise ΣMloadA x (input load of point load A) = Active load A
The value of the input load A can be changed using Staged construction as
Loading input while using Total multipliers as Loading input may be used to
change the load multiplier.

Define load displacement points

After the calculation it is possible to create load-displacement curves. These can be used
to inspect the behaviour in a node during the calculation steps. In order to create load-
displacement curves it is first necessary to indicate for which node(s) the displacements
should be traced.

• Click on the Select points for curves button in the toolbar. This will result in a plot of
the mesh, showing all generated nodes. Click on the node, located in the centre directly
underneath the footing. For a correct selection of this node it may be necessary to use
the zoom option . After selection of the node it will be indicated as point A. Press

the Update button to proceed to calculations.

Start the calculation

After definition of the last calculation phase, the calculation process is started by clicking the
Calculation button . This will start the calculation. During the calculation a calculation
window appears showing the status and some parameters of the current calculation phase.
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INSPECT OUTPUT

After each successful execution of a calculation phase PLAXIS will indicate the phase with
a green check mark ( ). This indicates a successful calculation phase. If during execution
either failure or an error occurs, PLAXIS marks the stage with a red cross ( ).

Figure 16: Calculation window with all phases calculated

• While phase 3 is highlighted, press the View calculation results button that will start
the output program, showing the deformed mesh for the situation with both horizontal
and vertical load applied, as presented in figure 17.

Figure 17: Deformed mesh at the end of phase 3
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• Check the various types of output, such as the deformed mesh, displacement contours,
effective (principal) stresses etc. These can be found from the Deformations and
Stresses menus.

• Still in the Output program, select from the dropdown list at the right of the toolbar the
output step belonging to phase 4.

• From the Displacements menu in the Output program now select Incremental
displacements and then the option |∆u|. Display the incremental displacements as
contours or shadings. The plot clearly shows a failure mechanism (see Figure 18).

Figure 18: Shadings of displacement increments after phase 4

Load displacement curves

• In the Output program, select the Curves manager from the Tools menu. The Curves
manager has 2 tabsheets, one for the curves defined in this project (currently none) and
one for the points selected to make load-displacement curves (currently 1 node that was
pre-selected, that is before the calculation).

• In the Curves manager select the button New to define a new curve. Now the Curve
generation window opens.

• On the x-axis we want to plot the settlement of our chosen point in the middle of the
footing. In the x-axis box choose point A from the dropdown list and then below in
Deformations and then Total displacements choose |u|.

• On the y-axis we want to plot the force applied on the footing, which is a global value
not connected to a specific node or stress point. In y-axis box choose Project from the
dropdown list to indicate we want to plot a global value, and then in Multipliers choose
ΣMLoadA.
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• Figure 19 shows the Curve generation window after applying the steps mentioned.

• Press OK to show the resulting curve. See also figure 20.

Figure 19: Curves generation window

Figure 20: Load displacement curve for the footing

The input value of point load A is 50 kN/m and the load multiplier ΣMloadA reaches approximately
4.6. Therefore the failure load is equal to 50 kN/m x 4.6 = 230 kN/m. You can inspect the load
multiplier by moving the mouse cursor over the plotted line. A tooltip box will show up with the
data of the current location.
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RESULTS DRAINED BEHAVIOUR

In addition to the mesh used in this exercise calculations were performed using a very coarse
mesh with a local refinement at the bottom of the footing and a very fine mesh. Fine meshes
will normally give more accurate results than coarse meshes. In stead of refining the whole
mesh, it is generally better to refine the most important parts of the mesh, in order to reduce
computing time. Here we see that the differences are small (when considering 15-noded
elements), which means that we are close to the exact solution. The accuracy of the 15-
noded element is superior to the 6-noded element, especially for the calculation of failure
loads.

Hint: In plane strain calculations, but even more significant in axi-symmetric
calculations, for failure loads, the use of 15-noded elements is recommended.
The 6-noded elements are known to overestimate the failure load, but are ok
for deformations at serviceability states.

The results of fine/coarse and 6-noded/15-noded analyses are given below.

Table 2: Results for the maximum load reached on a strip footing on the drained sub-soil for
different 2D and 3D meshes

Mesh size Element
type

Nr. of
elements

Max.
load

Failure
load

[kN/m] [kN/m2]
very coarse mesh with local refinements
under footing

6-noded 79 281 146

coarse mesh 6-noded 121 270 141
very fine mesh 6-noded 1090 229 121
very coarse mesh with local refinements
under footing

15-noded 79 236 124

coarse mesh 15-noded 121 248 130
very fine mesh 15-noded 1090 220 116
Analytical solutions of:
- Vesic
- Brinch Hansen
- Meyerhof

117
98
97

In this table the failure load has been calculated as:

Qu

B
= Maximumforce

B
+ γconcrete ∗ d = Maximumforce

2
+ 6

From the above results it is clear that fine FE meshes give more accurate results. On the other
hand the performance of the 15-noded elements is superior over the performance of the lower
order 6-noded elements. Needless to say that computation times are also influenced by the
number and type of elements.
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ADDITIONAL EXERCISE:

UNDRAINED FOOTING

Computational Geotechnics 23



Elastoplastic analysis of a footing

24 Computational Geotechnics



Elastoplastic analysis of a footing

INTRODUCTION

When saturated soils are loaded rapidly, the soil body will behave in an undrained manner, i.e.
excess pore pressures are being generated. In this exercise the special PLAXIS feature for
the treatment of undrained soils is demonstrated.

SCHEME OF OPERATIONS

In PLAXIS, one generally enters effective soil properties and this is retained in an undrained
analysis. In order to make the behaviour undrained one has to select ‘undrained’ as the Type
of drainage. Please note that this is a special PLAXIS option as most other FE-codes require
the input of undrained parameters e.g. Eu and νu.

Aims

• The understanding and application of undrained soil behaviour

• How to deal with excess pore pressures.

A) Geometry input

• Use previous input file

• Save as new data file

• Change material properties, undrained behaviour for clay

• Mesh generation, global mesh refinement

B) Calculations

• Re-run existing calculation phases

• Construct footing

• Apply vertical force

• Apply horizontal force

C) Inspect output

• Inspect excess pore pressures
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GEOMETRY INPUT

Use previous input file

• Start PLAXIS by clicking on the icon of the Input program.

• Select the existing project file from the last exercise (drained footing).

• From the File menu select Save As and save the existing project under a new file name
(e.g. ‘exercise 1b’)

Change material properties

Change material properties by selecting the item Soils & Interfaces from the Materials menu
or click on the Material sets button . Select the ’clay’ from the Material sets tree view and click
on the Edit button. On the first tab sheet, General, change the Drainage type to "Undrained
A" and close the data set.

Figure 21: Set drainage type to "Undrained A"

Mesh generation

The mesh generator in PLAXIS allows for several degrees of refinement. In this example
we use the Refine global option from the Mesh menu, which will re-generate the mesh,
resulting in an increased number of finite elements to be distributed along the geometry lines.
Notice the message that appears about staged being reconstructed: the program will take into
account the newly generated mesh for the previously generated initial conditions and staged
construction phases. From the output window, in which the mesh is shown, press the continue

button to return to the Input program.
Hint: After generation of a finer mesh, the geometry may be refined until a

satisfactory result appears. Besides the option Refine global several other
methods of refinement can be used.
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Hint: After re-generation of the finite element mesh new nodes and stress points
exists. Therefore PLAXIS has to regenerate pore water pressures and initial
stresses. This is done automatically in the background when regenerating the
mesh. Also, the new mesh is taken into account for any change to calculation
phases with the exception of ground water flow analysis.

After generating the mesh one can now continue to the calculation program. Click on the
Caculations button to proceed to the calculations program. Click ‘yes’ to save the data.

CALCULATIONS

Re-run existing calculation list

The calculation list from example 1 appears, as indicated below. All phases are indicated
by (blue arrows). After mesh (re)generation, staged construction settings remain and phase
information has been rewritten automatically for the newly generated mesh. However, this is
not the case for points for load displacement curves due to the new numbering of the mesh
nodes.

• Click on the Select points for curves button in the toolbar. Reselect the node located
in the centre directly underneath

• Click on the Calculate button to recalculate the analysis. Due to undrained behaviour
of the soil there will be failure in the 3rd and 4th calculation phase.

INSPECT OUTPUT

As mentioned in the introduction of this example, the compressibility of water is taken into
account by assigning ’undrained’ behaviour to the clay layer. This results normally, after
loading, in excess pore pressures. The excess pore pressures may be viewed in the output
window by selecting:

• Select in the calculation program the phase for which you would like to see output results.

• Start the output program from the calculation program by clicking the View output button .

• Select from the Stresses menu the option Pore pressures and then pexcess, this results in
Figure 22 .

The excess pore pressures may be viewed as stress crosses ( ), contour lines ( ),

shadings ( ) or as tabulated output ( ). If, in general, stresses are tensile stresses
the principal directions are drawn with arrow points. It can be seen that after phase 3 on the
left side of the footing there are excess pore tensions due to the horizontal movement of the
footing. The total pore pressures are visualised using the option of active pore pressures.
These are the sum of the steady state pore pressures as generated from the phreatic level
and the excess pore pressures as generated from undrained loading.
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Figure 22: Excess pore pressures at the end of the 3rd phase

• Select from the Stresses menu the option Pore pressures and then pactive. The results
are given in Figure 23.

From the load displacement curve it can be seen that the failure load in the last phase is
considerably lower for this undrained case compared to the drained situation, as expected.
For the undrained case the failure load is approx. 70 kPa.
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Figure 23: Active pore pressures at the end of phase 3
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APPENDIX A: BEARING CAPACITY CALCULATION

Given the formula for bearing capacity of a strip footing:

Qf

B
= c ·Nc + 1

2
γ′B ·Nγ

Nq = eπ tanϕ′
tan2(45 + 1

2
ϕ′)

Nc = (Nq − 1) cotϕ′

Nγ =


2(Nq + 1) tanϕ′ (V esic)

1.5(Nq − 1) tanϕ′ (BrinchHansen)

(Nq − 1) tan(1.4ϕ′) (Meyerhof)

Filling in given soil data:

Nq = eπ tan(20) tan2(55) = 6.4
Nc = (6.4− 1) cot(20) = 14.84

Nγ =


2(6.4 + 1) tan(20) = 5.39 (V esic)

1.5(6.4− 1) tan(20) = 2.95 (BrinchHansen)

(6.4− 1) tan(28) = 2.97 (Meyerhof)

The effective weight of the soil:

γ′ = γw − 10 kN/m3 = 18− 10 = 8 kN/m3

For a strip foundation this gives:

Qf

B
= c ·Nc + 1

2
γ′B ·Nγ =


5 ∗ 14.83 + 1

2
∗ 8 ∗ 2 ∗ 5.39 ≈ 117kN/m2 (V esic)

5 ∗ 14.83 + 1
2
∗ 8 ∗ 2 ∗ 2.95 ≈ 98kN/m2 (BrinchHansen)

5 ∗ 14.83 + 1
2
∗ 8 ∗ 2 ∗ 2.87 ≈ 97kN/m2 (Meyerhof)
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